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Chapter 1: Welcome to FileMaker Pro
Welcome to the FileMaker® Pro 4.1 application. FileMaker Pro is
designed to help you manage information easily and effectively.

About this guide
This FileMaker Pro Installation and New Features Guide tells you how
to install the application on your Windows or Mac OS computer.
Note When a feature or procedure is specific to a particular platform,
you see instructions and illustrations that are also specific to that
platform. For features or procedures that are similar on both platforms,
you may see illustrations for either Windows or the Mac OS.

1 Chapter 1, “Welcome to FileMaker Pro,” explains system
requirements and what you have to do before using FileMaker Pro.

1 Chapter 2, “Installing FileMaker Pro in Windows,” provides
instructions for installing the application on a Windows-based
computer.

1 Chapter 3, “Installing FileMaker Pro in the Mac OS,” provides
instructions for installing the application on a Mac OS-based
computer.

1 Chapter 4, “New features in FileMaker Pro,” provides an overview of
the new features in FileMaker Pro 4.1 and FileMaker Pro 4.0. This
chapter is especially helpful for users upgrading from previous
versions of FileMaker Pro.

1 Chapter 5, “ODBC import with FileMaker Pro,”gives instructions for
importing data from ODBC data sources, a new feature in
FileMaker Pro 4.1.

1 Appendix A, “MacIPX control panel,” provides information for
networking using MacIPX in the Mac OS.

1 Appendix B, “Installing Win32s,” provides information on installing
and removing Win32s.
This installation guide, the FileMaker Pro User’s Guide, and the
onscreen Help system work together to give you the information you
need to know as you learn about FileMaker Pro.
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Registration and customer support
If a product registration card was included with your software purchase,
we encourage you to take the time to complete and mail it to us. In some
products an electronic version of the registration card is included for
your convenience.
Please refer to our Web site at http://www.filemaker.com
(http://www.filemaker.com/intl outside of North America) for information
concerning customer and technical support. At our Web site you will find
the FileMaker, Inc. Service Directory (detailing the service options
available to U.S. and Canadian customers), answers to frequently asked
questions, and access to extensive software libraries used by our technicians
to help find solutions. If you do not have access to the Web, you may learn
about the service options available to U.S. and Canadian customers by
calling 1-800-965-9090. For customers outside the U.S. or Canada, please
refer to the Technical Support sheet included with the software.

What you need to install FileMaker Pro
This guide gives instructions for installing the FileMaker Pro application
and associated files on your Windows or Mac OS computer. Before you
begin installing, you must know how you plan to use FileMaker Pro.

1 On a stand-alone computer—you want to use FileMaker Pro on your
computer, and you don’t plan to share files with other users over
a network.

1 With networking—you want to use FileMaker Pro on your computer,
and you plan to share FileMaker Pro files with other computers using
either TCP/IP or IPX/SPX networking software (Windows) or
TCP/IP, MacIPX, or AppleTalk networking software (Mac OS).
If you’re on a network You need to know which type of network you’re
using. If you’re not sure which network option to choose, check with
your network administrator before you begin installation.

Installation code
The installation code is a seventeen-digit number located on either a
two-part sticker attached to the front of the paper CD envelope cover
(North America) or a three-part sticker attached to a separate paper sheet
within the box (International).
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Important You must enter the installation code during installation or the

software will not install.
The installation code ensures adherence to the single user license
agreement, which allows for use of one (1) copy of the Software on a
single computer at a time (refer to your Software License). If the code is
invalid or if another copy of the application installed with that same code
is running on the network, the installation program or application launch
stops and the software displays this error message:
“The maximum number of licensed users are currently using this
copy of FileMaker Pro. Please refer to the installation code section of
your Installation and New Features Guide for further instructions.”
If you receive this error message, you have entered a duplicate
installation code. To install FileMaker Pro on multiple computers, you
must have a unique installation code for each user, or obtain a volume
license. You must purchase a copy of FileMaker Pro for each user.

Minimum hardware and software requirements
To install and use FileMaker Pro, you need the CD-ROM in the
FileMaker Pro package and the following minimum equipment
and software:
Windows:

1 an Intel compatible 486/33 PC or higher with 8 MB of RAM (16 MB
of RAM recommended)

1 a hard disk
1 a CD-ROM drive
1 Windows 98, Windows 95, Windows NT 3.51 or later, Windows for
Workgroups 3.11, or Windows 3.1
Note ODBC import and Web publishing are not supported in Windows
3.1 or Windows for Workgroups.
Mac OS:

1 a Macintosh or Mac OS computer with at least 8 MB of RAM (16 MB
recommended)

1 a hard disk
1 a CD-ROM drive
1 System 7.1 or later, or Mac OS 8.0 or later
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Note ODBC import is not supported in 680x0 Macintosh computers and
Web publishing is not supported in 68000 Macintosh computers.
Memory settings In the Mac OS, to see the minimum and preferred
application memory settings for FileMaker Pro, select the
FileMaker Pro application icon after installation and choose Get Info
from the File menu. For information about adjusting the memory
allocated to FileMaker Pro, see “Adjusting memory” on page 3-8.

Networking requirements
We recommend using the TCP/IP protocol for networking the
FileMaker Pro application on both Windows and Mac OS networks.
Windows:

To share files among users on a network, you need to have the following
additional software and hardware installed on your PC:

1 a Windows-compatible network card
1 the software driver for your network card
1 the appropriate TCP/IP network protocol or IPX/SPX network
protocol for Windows 98, Windows 95, Windows NT, Windows for
Workgroups, or Windows 3.1
Mac OS:

To share files among users on a network, you can use TCP/IP, MacIPX,
or AppleTalk networking software.
Using MacIPX with AppleTalk When you choose MacIPX for networking,

you can still access your AppleTalk printers and AppleShare servers.
MacIPX is used for networking FileMaker Pro files only.
For more information about MacIPX, see appendix A, “MacIPX control
panel.”
If you are using a 68000 Macintosh computer, such as a Macintosh Plus,

Macintosh SE, Macintosh Portable, or PowerBook 100, you should use
only the AppleTalk protocol. MacIPX and MacTCP have only limited
support on these computers.
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You can use one of the following solutions to share files on a mixed
Windows and Mac OS network.
Windows 98 or
Windows 95

Windows NT

Windows for
Workgroups

Windows 3.1

Mac OS

Microsoft
TCP/IP-32 version
3.11b

Network
TeleSystems
TCP Pro 3.0 or later

MacTCP 2.0.6 or
later or Open
Transport 1.1 or later

TCP/IP
Microsoft TCP/IP
(recommended)

Microsoft TCP/IP

IPX/SPX

Microsoft NWLink
Novell NetWare
Novell NetWare
MacIPX version
IPX/SPX Compatible Client Software Shell Client Software Shell 1.3.1
Transport
version 3.26 or later version 3.26 or later

IPX/SPX -compatible
Protocol (Microsoft
implementation)

Web publishing requirements
To publish a database on the Web using the FileMaker Pro Web
Companion, you need a host computer with access to the Internet or an
intranet via TCP/IP. If the host computer is Windows-based, it must run
Windows 98, Windows 95, or Windows NT 3.51 or later. If the computer
is Mac OS-based, it must run System 7.1 or later or Mac OS 8.0 or later.
Note Web publishing in FileMaker Pro 4.1 is not supported under

Windows 3.1 or Windows for Workgroups, or under 68000 Macintosh
computers.
Important Access to the Internet requires an Internet service provider

(ISP). FileMaker Pro does not provide an Internet account for you.

Requirements for advanced features (Windows)
Some of the advanced features of FileMaker Pro require
additional software.
FileMaker Pro
advanced feature

Software requirement

ODBC import

ODBC 2.0 or later drivers. If these have not been installed by
another application, you may opt to use the program files and
drivers located in the FileMaker Pro 4.1 CD-ROM

URL support

URL.DLL

Open URL script step

URL.DLL

Send Mail script step

MAPI (Mail API) enabled email client software

Phone dialing

Phone dialer or other TAPI (Telephony API) compliant software

Custom Web Publishing

An HTML editing application, such as Home Page 3.0 software.
Web browser software is suggested to view your work.

IntelliMouse support

IntelliPoint software (included with the IntelliMouse)
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The DLL and the API files are installed with a Typical installation of
Windows 98, Windows 95, Windows NT 3.51 and Windows NT 4.0.

Requirements for advanced features (Mac OS)
FileMaker Pro
advanced feature

Software requirement

ODBC import

Install ODBC program files and drivers located in the
FileMaker Pro 4.1 CD-ROM (ODBC import is not supported
on 680x0 Macintosh computers)

URL support

Internet Config 1.1 or later

Open URL script step

Internet Config 1.1 or later

Send Mail script step

Internet Config 1.1 or later and email client software

Send Apple event script step AppleScript system software
Custom Web Publishing

An HTML editing application, such as Home Page 3.0 software.
Web browser software is suggested to view your work.

AppleScript is installed with a normal Mac OS software installation. The
Internet Config application and extension are installed with some versions
of the Mac OS system software. If you don’t have this software, refer to
the Apple Computer, Inc. Web site at www.apple.com.

Before you begin
Before you begin the installation process, exit or quit other open programs
and save your work, and turn off virus protection utilities.
For instructions on installing FileMaker Pro on a computer using
the Windows operating system, see chapter 2, “Installing FileMaker Pro
in Windows.”
For instructions on installing FileMaker Pro on a computer using the
Mac OS, see chapter 3, “Installing FileMaker Pro in the Mac OS.”

Upgrading from previous versions
After you install, you might need to update the FileMaker Pro User
Dictionary. If you’re upgrading from FileMaker Pro 2.x or earlier, you
will also need to convert your database files to FileMaker Pro 4.1.
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Updating your User Dictionary
If you have added words to your User Dictionary in either a previous
version of FileMaker Pro or another FileMaker, Inc. (or Claris) product,
then you must export that User Dictionary to a text file, then import it
into the User Dictionary in FileMaker Pro 4.1.
To export the User Dictionary from FileMaker Pro 2.x and later:
1. In your previous version of FileMaker Pro, choose Spelling from the

Edit menu, then choose User Dictionary.
2. Click Text File (or the Text flag in FileMaker Pro 2.x) to show the Import

and Export buttons.
3. Click Export and export the text file containing the words from your

previous User Dictionary.
To import this file into the User Dictionary in FileMaker Pro 4.1:
1. Open a database in FileMaker Pro 4.1, choose Spelling from the Edit

menu, then choose Edit User Dictionary.
2. Click Text File to show the Import and Export buttons.
3. Click Import and import the text file containing the words from your

previous User Dictionary.

Opening files from previous versions
FileMaker Pro 4.1 can open both Windows and Mac OS-compatible
files created by FileMaker Pro 2.0 or later.
FileMaker Pro 3.x databases

You do not need to convert 3.x files. In FileMaker Pro 4.x, you can open
files created with FileMaker Pro 3.x; in FileMaker 3.x, you can open
files created with FileMaker Pro 4.x. However, new 4.x features are not
supported when you open files in 3.x. For example, rotated fields will
appear as ordinary fields in 3.x.
FileMaker Pro 2.x databases

When you convert a FileMaker Pro 2.x file, FileMaker Pro 4.x software
saves your original FileMaker Pro 2.x file and creates a copy that has
been converted to the FileMaker Pro 3.x-4.x format. The original file is
not modified and you can open it in FileMaker Pro 2.x. The converted
file can only be opened in FileMaker Pro 3.x or FileMaker Pro 4.x.
Important Save a backup copy of your database files before opening

them in FileMaker Pro 4.1.
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To convert and open a FileMaker Pro 2.x file:
1. Start FileMaker Pro 4.1.
2. Choose Open from the File menu and select the file you want to

convert in the Open dialog box.
You see the Conversion dialog box.
3. Click OK to append “Old” to the name of the original FileMaker Pro

2.x file.

4. After you click OK, you see another dialog box where you can name

the new, converted file.
By default, this converted file will have the original file’s name.
Preserving this name is important if you have existing lookups or
scripts, which might not function correctly if it is changed.
5. Click Save to start the conversion.

FileMaker Pro converts the file and opens it.
FileMaker Pro 1.x databases

To use a database created by FileMaker Pro 1.0, you must first convert
it on a Mac OS computer using FileMaker Pro 2.x or later. Afterwards,
refer to the instructions in either of the two preceding sections, as
appropriate, to convert your file to FileMaker Pro 4.1.
Cross-platform considerations

If you want to use a FileMaker Pro 2.x or later file on a Windows-based
system, and that file was originally created using a version of
FileMaker Pro for the Mac OS, you must add the appropriate extension
to the file’s name. For files that are still in the FileMaker Pro 2.x format,
add .fm to the file’s name. For files that are in either the FileMaker Pro
3.x or FileMaker Pro 4.x format, add .fp3 to the file’s name.

Chapter 2: Installing FileMaker Pro in Windows
Before you begin the installation process, exit other open programs and
save your work, and turn off virus protection utilities.
Note For instructions on installing FileMaker Pro on a Mac OS–based

computer, see chapter 3, “Installing FileMaker Pro in the Mac OS.”

Installing with Windows 98, Windows 95 or Windows NT 4.0
You must use the installation program to install FileMaker Pro—you
can’t install FileMaker Pro by dragging files to your hard disk.
To install FileMaker Pro on your hard disk:
1. Insert the CD-ROM into your CD-ROM drive.

You see the FileMaker Pro screen.

2. For late-breaking information about FileMaker Pro, view the Read

Me file. You can also browse the contents of the CD, if you wish.
3. Click the Install FileMaker Pro 4.1 button.

You see the software license agreement.
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4. Click Accept to agree to the terms of the license agreement.

You see the Welcome screen.
5. Click Next.

You see the FileMaker Pro Installation dialog box.

Follow the steps described in one of the following sections:

1 If you want to install all the available files, continue with
Typical installation.

1 If you want to install a subset of the FileMaker Pro files, skip to
“Compact installation or Custom installation” on page 2-5.
With a Compact installation, the following files are not installed:

1
1
1
1

Networking files
Web Companion and Web publishing files
Tutorial and example files
Dictionary files

With a Custom installation, you can install just the files you want.

Installing FileMaker Pro in Windows 2-3

Typical installation
Follow these steps to install the complete FileMaker Pro package on
your Windows 98, Windows 95 or Windows NT 4.0 system.
To install all the FileMaker Pro files on your hard disk:
1. If you have not already done so, insert the CD-ROM.

Follow the instructions on page 2-1.
2. In the FileMaker Pro Installation dialog box, choose Typical.

If you want to install FileMaker Pro in another folder or on another
drive, click the Browse button. If the selected disk doesn’t have
enough space for the files you select, you can leave the installer and
delete existing files to make more room on the disk. If the disk is
write-protected, or isn’t a hard disk, you can choose another drive.
3. Click Next.

You see the Network Protocol dialog box.

If you want to network your files, select a protocol. You can change
the network protocol later, without re-installing the program. For help
in deciding which network protocol to select, see your network
administrator.
4. Click Next.

The installer tells you if the selected drive doesn’t have enough space
for the files you select.
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Otherwise, you see the Personalization dialog box.

Type your
name here

Type your
installation
code here

5. In the Name box, type your name and press the Tab key.
6. Type your company name, if applicable, and press Tab.

If you don’t have a company name, you can put other information
(like your address) in the box or leave it blank.
7. In the Installation Code box, type your FileMaker Pro installation code.

The installation code is a seventeen-digit number located on either a
two-part sticker attached to the front of the paper CD envelope cover
(North America) or a three-part sticker attached to a separate paper
sheet within the box (International).
Important You must enter the installation code during installation or

the software will not install. See “Installation code” on page 1-2 for
more information.
8. Click Next.

If you’ve made an error in typing, follow the instructions provided on
the screen.
After the installation program copies all the files, it creates a menu
item for FileMaker Pro in the Start menu.
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Compact installation or Custom installation
To install a subset of FileMaker Pro files on your hard disk:
1. If you have not already done so, insert the CD-ROM.

Follow the instructions on page 2-1.
2. In the FileMaker Pro Installation dialog box, choose Compact or

Custom.

If you want to install FileMaker Pro in another folder or on another
drive, click the Browse button. If the selected disk doesn’t have enough
space for the files you select, or is write-protected, you can leave the
installer and delete existing files to make more room on the disk. If the
disk is locked, or isn’t a hard disk, you can choose another drive.
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3. Click Next.

If you’ve selected Custom, the dialog box lists the files you can install.

Files you can install

4. For a Custom installation, click to the left of an item to select the files

you want to install.
Any file with a checkmark will be installed.
5. Click Next.

If you are installing the FileMaker Pro application, you see the
Personalization dialog box.
6. In the Name box, type your name and press the Tab key.
7. Type your company name, if applicable, and press Tab.

If you don’t have a company name, you can put other information
(like your address) in the box or leave it blank.
8. In the Installation Code box, type your FileMaker Pro installation code.

The installation code is a seventeen-digit number located on either a
two-part sticker attached to the front of the paper CD envelope cover
(North America) or a three-part sticker attached to a separate paper
sheet within the box (International).
Important You must enter the installation code during installation or

the software will not install. See “Installation code” on page 1-2 for
more information.
9. Click Next.
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If you’ve made an error in typing, follow the instructions provided on
the screen.
10. Click Next.

The Installer begins copying files. A dialog box tells you what the
Installer is doing.
After the selected files are installed, a final dialog box tells you the
installation on your hard drive was successful.
If you’ve installed the FileMaker Pro application, the installation
program creates a menu item for FileMaker Pro in the Start menu.

Uninstalling FileMaker Pro for Windows 98, Windows 95, or Windows NT 4.0
1. Open the Add/Remove Programs control panel.
2. Click the Install/Uninstall tab and select FileMaker Pro 4.1 from the list.
3. Click Add/Remove.

Earlier versions of FileMaker Pro can be removed the same way.
Note Uninstalling doesn’t delete files that you’ve created, as long as

they are named differently than the sample and template files that are
installed with FileMaker Pro.

Installing with Windows 3.1, Windows for Workgroups,
or Windows NT 3.51
If you are using Windows 3.1 or Windows for Workgroups 3.11, you
need to install Win32s 1.30c before installing FileMaker Pro. If an
earlier version of Win32s is installed on your system, the older version
must be removed and Win32s 1.30c must be installed. See appendix B,
“Installing Win32s” for further information.
Note ODBC import is not supported in Windows 3.1 or Windows for
Workgroups.
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Typical installation
To install FileMaker Pro with Windows 3.1, Windows for Workgroups
3.11, or Windows NT 3.51:
1. Start Windows.
2. Insert the CD-ROM into the CD-ROM drive.
3. Choose Run from the Program Manager’s File menu.
4. Type the drive letter for the CD-ROM drive and the path for the setup
command in the Command Line box (for example, d:\setup) and

click OK.
5. Follow the installation instructions provided on the screen.

Compact installation or Custom installation
For information on installing a subset of the FileMaker Pro files, see
“Compact installation or Custom installation” on page 2-5.

Uninstalling FileMaker Pro for Windows 3.1, Windows for Workgroups,
or Windows NT 3.51
1. Open the FileMaker Pro program group.
2. Double-click Uninstall FileMaker Pro.
Note Uninstalling doesn’t delete files that you’ve created, as long as

they are named differently than the sample and template files that are
installed with FileMaker Pro.

Where files are stored on your hard disk
The following tables show the files and folders you can install, and
the preferred location for them on your hard disk. With a Typical
installation, the FileMaker Pro Installer installs all the files you need in
their preferred locations.

Location of the FileMaker Pro 4.1 folder
In Windows 98, Windows 95 and Windows NT 4.0, the
FileMaker Pro 4.1 folder is installed by default in the FileMaker folder
in the Program Files folder (C:\Program Files\FileMaker\
FileMaker Pro 4.1). In Windows 3.1, Windows for Workgroups, or
Windows NT 3.51, the FileMaker Pro directory is installed by default in
the root directory (C:\fmpro41).
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Contents of the FileMaker Pro 4.1 and fmpro41 folders
This table shows the location and contents of items installed in a Typical
installation.
Folder location
in Windows 95,
Windows 98 and
Windows NT 4.0

Folder location
in Windows 3.1, Windows
for Workgroups, and
Windows NT 3.51

C:\Program Files\FileMaker\
FileMaker Pro 4.1

C:\fmpro41

File or folder

Description

FILEMAKER PRO.EXE Application file
(FMPRO.EXE in
Windows 3.1, and
Windows for
Workgroups)
README.WRI

Text document about FileMaker Pro

CLLNGENU.DLL

Claris Spelling engine module

FMENGINE.DLL

FileMaker application module

FMOLE.DLL

FileMaker application module

FMRSRC.DLL

FileMaker application module

FMATM16.DLL

Support for Adobe Type Manager
(Windows 98, Windows 95 and
Windows NT 4.0 only)

FMATM32.DLL

Support for Adobe Type Manager
(Windows 98, Windows 95 and
Windows NT 4.0 only)

FMTOOLS.DLL

FileMaker application module

FMPRO41.HLP
FMPRO41.CNT

FileMaker Pro online help documents

FMPRO41.FTS

A file generated by the Help system

FMPRO41.GID

A file generated by the Help system

CLPROOF.DLL

Spelling engine

C:\Program Files\FileMaker\
FileMaker Pro 4.1\Template

C:\fmpro41\template

TEMPLATE

Folder containing predesigned
templates that help you use
FileMaker Pro right away

C:\Program Files\FileMaker\
FileMaker Pro 4.1\Examples

C:\fmpro41\examples

EXAMPLES

Folder containing database examples
that use the relational capabilities of
FileMaker Pro 4.1

C:\Program Files\FileMaker\
FileMaker Pro 4.1\Tutorial

C:\fmpro41\tutorial

TUTORIAL.FP3

A FileMaker Pro tutorial database

C:\Program Files\FileMaker\
FileMaker Pro 4.1\Web
(for Web publishing, do not
move or rename this folder)

C:\fmpro41\web
(Windows NT 3.51 only)

Employee Database files
Guest Book files
Shopping Cart files

Example databases and HTML files
that you can use to learn about Custom
Web Publishing
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Folder location
in Windows 95,
Windows 98 and
Windows NT 4.0

Folder location
in Windows 3.1, Windows
for Workgroups, and
Windows NT 3.51

C:\Program Files\FileMaker\ C:\fmpro41\web tools
FileMaker Pro 4.1\Web Tools (Windows NT 3.51 only)

C:\Program Files\FileMaker\
FileMaker Pro 4.1\Web
Security

C:\fmpro41\web security
(Windows NT 3.51 only)

C:\Program Files\FileMaker\
FileMaker Pro 4.1\Odbc
C:\Program Files\FileMaker\
FileMaker Pro 4.1\System

File or folder

Description

CDML Reference

For Custom Web Publishing, a
FileMaker database that documents
how to use CDML to create HTML
format files for Custom Web
Publishing; contains a Developer’s
Guide

CDML Tool

For Custom Web Publishing, a
FileMaker database that helps you
create HTML files that contain CDML
tags, using Copy and Paste

CDML Template folder

For Custom Web Publishing, HTML
files containing CDML tags for the
standard actions (Add Record, Search,
and so on), to be used as building
blocks for your Custom Web
Publishing files

Databases folder

A folder containing the FileMaker
databases and HTML files required to
use Web Security Database safeguards

Security folder
ODBC Example folder
ODBC Installer folder

C:\fmpro41\system

USENGLSH.MPR
UKENGLSH.MPR

Contains the ODBC example files and
the evaluation ODBC drivers
The primary dictionaries that
FileMaker Pro uses to spell check your
files. You can select either U.S. or
British spellings for your main
dictionary. Each dictionary contains
over 100,000 words.

USER.UPR

The dictionary that stores your
customized list of spelling exceptions
and additions to the primary
dictionaries

CLADDON.CLR

An additional dictionary that contains
computer terminology

DELSL1.ISU

A log file, used by the uninstaller

FMIPX32.NET

IPX/SPX network plug-in

FMTCP32.NET

TCP/IP network plug-in

CWORKS.IMP

ClarisWorks database translation filter

DBF.IMP

DBF database translation filter

EXCEL.IMP

Microsoft Excel translation filter

FMBMP32.FLT

BMP graphic filter
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Folder location
in Windows 95,
Windows 98 and
Windows NT 4.0

Folder location
in Windows 3.1, Windows
for Workgroups, and
Windows NT 3.51

File or folder

Description

FMCGM32.FLT

CGM graphic filter

FMDRW32.FLT

DRW graphic filter

FMMAC32.FLT

MacPaint graphic filter

FMPCX32.FLT

PCX graphic filter

FMPIC32.FLT

PIC graphic filter

FMSLD32.FLT

Lotus SLD graphic filter

FMTIFF32.FLT

TIFF graphic filter

FMWMF32.FLT

Metafile graphic filter

CTL3D32.DLL

Windows 3-D interface (Windows 3.1,
Windows for Workgroups, and
Windows NT 3.51 only)

FMHOSTS.TXT

Stores your lists of hosts which appear
in the TCP/IP network dialog box

ODBC.IMP

ODBC translation filter

WEBCOMPN.FMX

The FileMaker Web Companion
plug-in that enables Web publishing
from FileMaker Pro (Windows 95,
Windows NT 3.51, and
Windows NT 4.0 only)

Windows System Directory folder
The following table shows the files and folders installed in the Windows
System Directory folder.
Folder location in
Windows 95 and
Windows NT 4.0
Windows System Directory

Folder location in Windows 3.1, Windows
for Workgroups, and Windows NT 3.51
\windows\system
(Windows 3.1 and Windows for Workgroups),
\winnt35\system32\
(Windows NT 3.51)

File or folder

Description

NWIPXSPX.DLL

Networking file

NWNETAPI.DLL

Networking file
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Adjusting the FileMaker Pro cache
FileMaker Pro maintains an internal cache of portions of your database.
Depending on your computer’s memory configuration, you may want to
adjust the cache size to improve performance.
You may want to consider increasing the cache size if you plan to:

1
1
1
1
1

work on a large database file
work on several database files at once
host database files
use a database file that contains many graphics
insert a large graphic into a database file

Consider decreasing the cache size if you plan to run several
applications at the same time and you have a limited amount of
memory (RAM) installed.
Note By changing the FileMaker Pro cache size, you also affect the

amount of memory needed to run FileMaker Pro.
For more information on managing memory, see the documentation that
came with your computer.

Changing the cache size
To change the cache size that FileMaker Pro uses:
1. In FileMaker Pro, choose Preferences from the Edit menu and then

choose Application.
You see the Application Preferences dialog box.
2. Click the Memory tab at the top of the dialog box.
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3. Type a number in the Attempt cache size of box.
4. Click Done.

The next time you start FileMaker Pro, the new cache size is used.

Adjusting network software
Depending on the networking protocol you’re using, you may have to
modify settings on the host and/or guest computers.

Changing the network protocol
During installation, you select a network protocol (or No Networking) for
FileMaker Pro. You can change the network protocol at any time.
You must choose a network protocol if you want to share FileMaker Pro
files over a network, either as a guest or as a host. For more information
about your network configuration, consult your network administrator.
Important The network protocol setting in FileMaker Pro must be the

same on the host and guest computers.
To change the network protocol:
1. Start FileMaker Pro 4.1.
2. Choose Preferences from the Edit menu, and then choose Application.

You see the Application Preferences dialog box. If necessary, click
the General tab to bring the General preferences to the front.
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3. Choose a network protocol from the Network Protocol drop-down list.

Note In Windows 3.1, FMIPX32.NET and FMTCP32.NET appear in the

drop-down list.
Changes to this setting don’t take effect until you exit FileMaker Pro and
then start it again.

IPX/SPX Considerations
Windows 98, Windows 95 or Windows NT To allow the maximum number

of guests (25), your IPX/SPX connections must be set to 60 or greater.
Consider increasing the SPX connections to 60 in the Network control
panel if you cannot connect the desired number of guests. You do not
need to modify settings in Windows NT.
Windows 3.1 or Windows for Workgroups 3.11 You should use the Novell

NetWare Client Shell version 3.26 or later to share FileMaker Pro files.
You’ll need to change Novell NetWare settings in order to network
FileMaker Pro. To share FileMaker Pro files over the network, your
machine must be a fully configured NetWare client.
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To share FileMaker Pro database files:

1 Use the Windows Setup program to set the network to the appropriate
NetWare option (usually NetWare 3.26 or later).

1 Add the following entries to your NET.CFG (or SHELL.CFG) file:
GET LOCAL TARGET STACKS=10
SPX CONNECTIONS=40

Get local target stacks needs to be set on all guest machines. SPX
connections should be set on the host machine if it will host more than
twelve guests, or on guest machines using additional SPX applications.
Consider increasing the SPX connections if you cannot connect the
desired number of guests.
Changing the frame type

After you select IPX/SPX as the network protocol, you must select a
frame type. A frame encapsulates packets of information in a
recognizable format; all computers communicating with each other on a
network must use the same frame type. For help in deciding which frame
type to select, see your network administrator.
Note If you are using TCP/IP networking, you do not need to change the

frame type.
Changing the frame type in Windows 98 or Windows 95

To change the frame type with IPX/SPX networking:
1. Open the Network control panel and click the Configuration tab.
2. Open IPX/SPX Compatible Protocol and click Properties.
3. Click the Advanced tab.
4. Click the frame type in the Property dialog box.
5. Make a selection from the Value drop-down list.
6. Click OK.

Both Windows 98 and Windows 95 prompt you to restart your computer
for these new changes to take effect.
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Changing the frame type in Windows NT

To change the frame type with IPX/SPX networking:
1. Right-click Network Neighborhood.
2. Select Properties from the menu.

You see the Network dialog box.
3. Click the Protocols tab.
4. Click NWLink IPX/SPX.
5. Click Properties.
6. Select a frame type from the drop-down list.
7. Click OK to apply the frame type.
8. Click OK to close the Network dialog box.

Windows NT prompts you to restart your computer for these new
changes to take effect.
Changing the frame type in Windows 3.1 and Windows for Workgroups

For information on changing the frame type in Windows 3.1 and
Windows for Workgroups, please refer to the documentation that came
with your networking software.

Where to go from here
After you install FileMaker Pro, you can immediately begin working
with the application. Here are some suggestions on where to go in the
documentation to get started:

1 If you’re new to databases or FileMaker Pro, read chapter 1,
“FileMaker Pro basics,” in the FileMaker Pro User’s Guide and
work through the online tutorial, located in the FileMaker Pro 4.1
folder.

1 If you’ve used FileMaker Pro before, read chapter 4 of this guide to
learn about new features available in FileMaker Pro 4.1 and 4.0.

1 If you’re upgrading from FileMaker Pro 4.0, read chapters 4 and 5 of
this guide to learn about new features such as the ODBC import
capability in FileMaker Pro 4.1.

Chapter 3: Installing FileMaker Pro in the Mac OS
Before you begin the installation process, quit other open programs and
save your work, and turn off virus protection utilities.
Note: For instructions on installing FileMaker Pro on a Windows-based
computer, see chapter 2, “Installing FileMaker Pro in Windows.”

Installing FileMaker Pro
You must use the installation program to install FileMaker Pro—you
can’t install the application by dragging files to your hard disk.

Starting the Installer
To start the FileMaker Pro Installer:
1. Insert the CD-ROM into your CD-ROM drive.

You see the disc’s window on your screen. If you see only the disc
icon, double-click the icon to open its window.
2. Double-click the file named Start Here.

You see the software license agreement.
3. Click Accept to accept the license agreement.

You see the FileMaker Pro Installer dialog box.
4. Follow the steps described in one of the following sections:

1 If you want to install all the available files, continue with “Easy
installation.”

1 If you want to install a subset of the FileMaker Pro files, skip to
“Custom installation” on page 3-4.

Easy installation
Follow these steps to install the complete FileMaker Pro package on
your hard disk. The Installer automatically installs the correct version
for either 680x0 Macintosh computers or Power Macintosh and
compatible computers.
Note ODBC import is not supported in 680x0 Macintosh computers and
Web publishing is not supported in 68000 Macintosh computers.
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To install FileMaker Pro on your hard disk:
1. If you have not done so already, start the Installer, as described on

page 3-1.
You see the FileMaker Pro Installer dialog box.

Choose Easy Install

Location where FileMaker Pro
will be installed

2. Specify the installation location, or use the default location.

1 If you don’t see the name of the hard disk where you want to install
FileMaker Pro, click the Switch Disk button, which appears only
when you have more than one volume mounted.

1 If you switch to a disk that isn’t a hard disk or is locked, the Install
button is dimmed and the dialog box tells you why you can’t install
onto that disk.

1 To select the folder in which you want to install the
FileMaker Pro 4.1 Folder, choose Select Folder from the pop-up
menu and select the desired folder.

1 If the selected disk doesn’t have enough space for the files you
select, you see a message. If you switch to the Finder software, you
can delete existing files to make more room on the disk. You can
also choose not to install some files (like the tutorial or template
files) by selecting Custom Install from the pop-up menu. For more
information, see “Custom installation” on page 3-4.
3. Click Install.
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You see the Personalize dialog box.

Type your name here

Type your Iistallation code here

4. In the Name box, type your name and press the Tab key.
5. Type your company name, if applicable, and press Tab.

If you don’t have a company name, you can put other information
(like your address) in the box or leave it blank.
6. Type your FileMaker Pro installation code.

The installation code is a seventeen-digit number located on either a
two-part sticker attached to the front of the paper CD envelope cover
(North America) or a three-part sticker attached to a separate paper
sheet within the box (International).
Important You must enter the installation code during installation or

the software will not install. See “Installation code” on page 1-2 for
more information.
Check your typing carefully. After you click OK, you can’t change the
name, company, or installation code unless you re-install
FileMaker Pro.
7. Click OK.

The Installer begins copying files. After all the files are installed, a
final dialog box tells you the installation on your hard disk was
successful.
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8. If you are installing the MacIPX networking software, click Continue.

(You must do a Custom Installation to install MacIPX. See the next
section, “Custom installation.”) Otherwise, click Quit to leave the Installer.
9. If you turned off virus protection and file sharing before installing,

turn them back on now.

Custom installation
To install a subset of FileMaker Pro files on your hard disk:
1. If you have not already done so, start the Installer, as described on

page 3-1
You see the FileMaker Pro Installer dialog box.
2. Choose Custom Install from the pop-up menu.

The dialog box lists the files you can install.

Choose Custom Install
Click here for
information about
the selected file

Files you can install

Total amount
of disk space
required for the
selected files

3. Select the files you want to install by selecting the checkboxes.
4. Specify the installation location, or use the default location.

1 If you don’t see the name of the hard disk where you want to install
FileMaker Pro, click the Switch Disk button, which appears only
when you have more than one volume mounted.

1 If you switch to a disk that isn’t a hard disk or is locked, the Install
button is dimmed and the dialog box tells you why you can’t install
onto that disk.

1 To select the folder in which you want to install the
FileMaker Pro 4.1 Folder or the specified files, choose
Select Folder from the pop-up menu and select the desired folder.
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1 If the selected disk doesn’t have enough space for the files you
select, you see a message. In the Finder software, you can delete
existing files to make more room on the disk. You can also choose
not to install some files (like the tutorial or template files) by
deselecting those files in the scrolling list.
5. Click Install.

If you’ve selected the application, you see the Personalize dialog box.
6. In the Name box, type your name and press the Tab key.
7. Type your company name, if applicable, and press Tab.

If you don’t have a company name, you can put other information
(like your address) in the box or leave it blank.
8. Type your FileMaker Pro installation code.

The installation code is a seventeen-digit number located on either a
two-part sticker attached to the front of the paper CD envelope cover
(North America) or a three-part sticker attached to a separate paper
sheet within the box (International).
Important You must enter the installation code during installation or

the software will not install. See “Installation code” on page 1-2 for
more information.
Check your typing carefully. After you click OK, you can’t change the
name, company, or installation code unless you re-install
FileMaker Pro.
9. Click OK.

The Installer begins copying files. After the selected files are
installed, a final dialog box tells you the installation on your hard disk
was successful.
10. Click Quit to leave the Installer.

If you installed the MacIPX networking software, the final dialog box
allows you to restart your computer. You must restart your computer
before you can use the new network software.
11. If you turned off virus protection and file sharing before installing,

turn them back on now.
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Where files are stored on your hard disk
The following table shows the files and folders you can install, and the
preferred location for them on your hard disk. If you install onto the
current system disk, the FileMaker Pro Installer places all the files you
need in their preferred locations.

FileMaker Pro 4.1 Folder
This table shows the files and folders installed in the FileMaker Pro
Folder.
FileMaker Pro 4.1 Folder

File or folder

Description

FileMaker Pro

The FileMaker Pro 4.1 application

FileMaker Pro Help

The FileMaker Pro onscreen Help system

FileMaker Pro Balloon Help

The FileMaker Pro onscreen Balloon Help system

Read Me

Late breaking news about FileMaker Pro

FileMaker Tutorial

FileMaker tutorial

A FileMaker Pro tutorial database

FileMaker Templates

Template files

Folder containing predesigned template files that help you use
FileMaker Pro right away

FileMaker Examples

Example files

Folder containing database examples that use the relational
capabilities of FileMaker Pro

FileMaker and Apple Events

Apple Events Reference

A FileMaker database that documents how to use Apple events
with FileMaker Pro

Sample Applications folder
Syntax Examples folder

Folders containing scripting examples, sample AppleScript,
and HyperCard applications

AppleTalk Network
MacIPX Network
TCP/IP Network

Modules that support AppleTalk, MacIPX, and TCP/IP
networks

ClarisWorks
DBF
Excel
ODBC

Filters for translating ClarisWorks database, DBF, Microsoft
Excel, and ODBC files

Web Companion

The FileMaker Web Companion plug-in that enables Web
publishing from FileMaker Pro

Employee Database files
Guest Book files
Shopping Cart files

Example databases and HTML files that you can use to learn
about Custom Web Publishing

FileMaker Extensions

Web
(for Web publishing, do not move
or rename this folder)
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FileMaker Pro 4.1 Folder

File or folder

Description

Web Tools

CDML Reference

For Custom Web Publishing, a FileMaker database that
documents how to use CDML to create HTML format files for
Custom Web Publishing; contains a Developer’s Guide

CDML Tool

For Custom Web Publishing, a FileMaker database that helps
you create HTML files that contain CDML tags, using Copy
and Paste

CDML Template

For Custom Web Publishing, a folder of HTML files
containing CDML tags for standard actions (Add Record,
Search, and so on) to be used as building blocks for your
Custom Web Publishing files

Databases

A folder containing the FileMaker databases and HTML files
required to use Web Security Database safeguards

Web Security

Security
ODBC

ODBC Example
ODBC Installer

Contains the ODBC example files and the evaluation ODBC
drivers

System Folder
This table shows the files and folders placed in your System Folder.
System Folder

File or folder

Description

Claris

FileMaker Help Viewer

The application that accesses the FileMaker Pro Help file

USENGLSH.MPR

The primary dictionaries that FileMaker Pro uses to spell check your
files. You can select either U.S. or British spellings for your main
dictionary. Each dictionary contains over 100,000 words.

UKENGLSH.MPR
USER.UPR

The dictionary that stores your customized list of spelling exceptions
and additions to the primary dictionaries

CLADDON.CLR

An additional dictionary that contains computer terminology

Claris Translators folder

Translators that FileMaker Pro uses to read graphics files created in
other applications

Claris XTND System

Translation engine

Control Panels

MacIPX control panel

Control panel for configuring MacIPX. This file is installed only in a
Custom installation.

Extensions

MacIPX AppleTalk
MacIPX Ethernet
MacIPX Token Ring

MacIPX interface files. These files are installed only in a Custom
installation.

XTND Power Enabler
Extension that enhances the XTND graphics importing capabilities of
(Power Macintosh and compatible FileMaker Pro on these computers
computers only)
Microsoft OLE Extension

Extension that is necessary for Microsoft Excel 5.0 import
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Adjusting memory
The Mac OS sets aside a certain amount of memory for FileMaker Pro.
However, you might need to change the amount of memory reserved for
FileMaker Pro if you plan to:

1
1
1
1
1
1

work on a large database file
work on several database files at once
host database files
use a database file that contains many graphics
insert a large graphic into a database file
run several applications at the same time, and you have a limited
amount of memory (RAM) installed

Changing the amount of memory used
If you want to change the amount of memory reserved for
FileMaker Pro, keep the following points in mind:

1 The amount of memory you give to FileMaker Pro affects your
ability to run other applications. If the Mac OS and FileMaker Pro
take up all the available memory, you won’t be able to open other
applications.

1 Avoid specifying less memory than the Suggested size in the
FileMaker Pro Info dialog box.
To change the amount of memory FileMaker Pro uses:
1. If FileMaker Pro is open, quit the application by choosing Quit from

the File menu.
2. In the Finder software, open the FileMaker Pro 4.1 Folder. Select the

FileMaker Pro application icon by clicking on it once.
Note If you click the application icon twice, you will start

FileMaker Pro. If that happens, choose Quit from the File menu and
try again.
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3. Choose Get Info from the File menu.

You see the FileMaker Pro Info window.

Change the amount of memory
FileMaker Pro uses here

4. In the Memory Requirements area at the bottom of the window,

double-click the Preferred size number and type a number to change
the memory allocated for FileMaker Pro.
If you can’t type in the box, make sure you’ve quit FileMaker Pro.
5. Click the close box.

The next time you start FileMaker Pro, the amount of memory you
specified is available for the application.

Choosing a network protocol
You must choose a network protocol if you want to use FileMaker Pro
over a network, either as a guest or as a host. For more information about
your network, consult your network administrator.
Important The network protocol setting in FileMaker Pro must be the

same on the host and all guest computers.
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To choose a network protocol:
1. Choose Preferences from the Edit menu, and then choose Application.

You see the Application Preferences dialog box. If necessary, choose
General from the pop-up menu at the top of the dialog box.
2. Choose a network protocol from the Network protocol pop-up menu.

3. Click Done.

Changes to this setting don’t take effect until you quit FileMaker Pro
and then start it again.

Where to go from here
After you install FileMaker Pro, you can immediately begin working
with the application. Here are some suggestions on where to go in the
documentation to get started:

1 If you’re new to databases, read chapter 1, “FileMaker Pro basics,” in
the FileMaker Pro User’s Guide to learn basic database concepts.

1 If you’re new to FileMaker Pro, work through the online tutorial,
which is automatically installed when you do an Easy Install.

1 If you’ve used FileMaker Pro before, read chapter 4 of this guide to
learn about new features available in FileMaker Pro 4.1 and 4.0.

1 If you’re upgrading from FileMaker Pro 4.0, read chapter 5 of
this guide to learn about the new ODBC import capability in
FileMaker Pro 4.1.

Chapter 4: New features in FileMaker Pro
This chapter introduces the new features in FileMaker Pro 4.1 and
FileMaker Pro 4.0.

ODBC import
FileMaker Pro 4.1 enables you to import data via Open Database
Connectivity (ODBC). If you have ODBC drivers installed and
configured, you can import data from a number of ODBC-compatible
data sources, including Oracle databases. The drivers query the data
source using Structured Query Language, or SQL, to determine which
records are imported. See the next chapter, “ODBC import with
FileMaker Pro,” for more information.

Runtime feature support
In FileMaker Pro 4.1, you can see and use features enabled in the
FileMaker Pro Developer Edition application, such as Kiosk mode.
The Developer Edition helps database developers quickly create and
deploy standalone FileMaker Pro runtime solutions for their customers.
Using FileMaker Pro 4.1, you can open these runtime databases, which
have features previously unsupported in FileMaker Pro:

1 Kiosk mode
1 custom menus
1 master access removed
Note These features can only be implemented in the FileMaker Pro

Developer Edition software. For more information on the Developer
Edition application, please visit our Web site at http://www.filemaker.com.

Support for Kiosk mode
When runtime solution database files are created in Kiosk mode, they do
not display operating system and application interface elements. As in a
presentation or slide show, the FileMaker Pro menu bar and menu
choices do not appear and the screen surrounding the primary database
file is black, even when opened in FileMaker Pro 4.1.
Important Before opening a file in Kiosk mode using FileMaker Pro 4.1,
close any shared FileMaker Pro files.
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Support for custom menu items
Using FileMaker Pro Developer Edition, database developers can
customize the name of the Script menu, connect a script to a custom
menu item in the Help menu, and connect a script to “About <solution
name>” (under the Help menu in Windows and under the Apple menu
in the Mac OS).
If a menu name is altered in the runtime solution, the custom menu name
will replace the menu name in the FileMaker Pro 4.1 file you’re
viewing. If a custom Help menu and script has been specified, it will be
available, along with the FileMaker Pro 4.1 onscreen help, under the
Help menu.

Remove master access
The FileMaker Pro Developer Edition software enables developers to
permanently remove access to Define Fields, Define Relationships,
Access Privileges, and the ScriptMaker® feature. This prevents anyone
from modifying the database structure in the runtime solution files.
If you open these databases in any version of FileMaker Pro, these
features will be unavailable to you. The files behave as if access
privileges are disabled for these features.

Euro character support
FileMaker Pro 4.1 now provides cross-platform support for the new
European currency symbol ( ). To use the Euro symbol with
FileMaker Pro, you must also be using an operating system and font that
support the new symbol.
To determine the keystroke for entering the Euro symbol, you can use a
keyboard mapping utility such as Character Map (Windows) or
Key Caps (Mac OS) to locate the character.
Warning FileMaker Pro files containing the Euro symbol may not
display the symbol correctly when opened with FileMaker Pro 4.0 and
earlier versions.

Both Windows 98 and Mac OS 8.5 include fonts that support this
character. For more information on the Euro character, visit the
Microsoft or Apple Web sites.
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Web publishing capabilities
Using FileMaker Pro 4.0 and 4.1, you can access your database from
almost anywhere in the world. Your file can be viewed, edited, sorted,
and searched with just Web browser software and access to the Internet
or your intranet. You can also choose how much or how little access
other users have to your file.
Note Access to the Internet requires an Internet service provider.

FileMaker Pro does not provide an Internet account for you.

Instant Web Publishing
With FileMaker Pro 4.0 and 4.1, you can quickly publish your database
on the Internet or on an intranet, using the FileMaker Pro Web
Companion.
This functionality is built in—no additional CGI or Web server software
is required for either the Mac OS, Windows 98, Windows 95, or
Windows NT. However, access to the Internet requires an Internet
account.
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Custom Web Publishing
You can create a complete, custom, interactive Web solution using the
FileMaker Pro Web Companion and dynamic HTML files.
FileMaker Pro now can publish HTML documents containing GIF and
JPEG graphics, animated GIF files, QuickTime movies, and AIFF files.
In addition, FileMaker Pro 4.0 and 4.1 support any custom Java applets
designed by a developer using the FileMaker Pro Developer Edition.
For step-by-step instructions on Web publishing, refer to the
FileMaker Pro User’s Guide and the CDML Reference database in the
Web Tools folder.

Internet features
FileMaker Pro 4.0 and 4.1 support many new Internet features, including
the ability to host databases on the Web.
Note Some of these features require additional software. See

“Requirements for advanced features (Windows)” on page 1-5 for
Windows computers and “Requirements for advanced features
(Mac OS)” on page 1-6 for Mac OS computers.

GIF and JPEG support
FileMaker Pro supports GIF and JPEG graphic formats in layouts,
container fields, and published Web pages. When FileMaker Pro sends
an image to a Web browser, it can send either a GIF or JPEG image. If
one is not available, the stored graphic is converted on-the-fly to JPEG
for display, even if it is not stored in JPEG format in the database.

Export to an HTML table
You can now export all or part of your database formatted as an HTML
table.

Send Mail script step
With email client software, you can send email via the Internet or your
intranet directly from your FileMaker Pro database.

New features in FileMaker Pro 4-5

URL support
With FileMaker Pro 4.0 and later, you can open a URL from a field. To
open a URL in Windows, right-click a URL in a field and choose Open
<URL> from the context menu. In the Mac OS, command-click a URL in
a field. If the address is for a Web page, FileMaker Pro opens your Web
browser software.

Open URL script step
You can create a script that opens a Web browser and goes to a
specified URL.

Expanded Sort and Find options
Related records can now be sorted within a portal or as part of a related list.
With the addition of exact field matches, Find requests can be even
more specific.

Calculation functions
In FileMaker Pro 4.0 and 4.1, new functions help you determine:

1
1
1
1
1

the current group that a password belongs to
the modifier key being pressed by the user
the network protocol that is loaded and in use
the ID of the current record
the number and kinds of objects in a layout

In addition, FileMaker Pro 4.0 and 4.1 support any custom plug-ins
designed by a developer using the FileMaker Pro Developer Edition.

4-6 FileMaker Pro Installation and New Features Guide

Layout and interface enhancements
Fields and objects can be rotated in 90-degree increments, allowing
greater flexibility in your layouts. Text can also be dragged and dropped
into a rotated text block.
To make creating and managing your files easier, value lists can be
defined from the File menu. Recently opened documents are listed in the
File menu on both the Mac OS and Windows platforms. You can turn
this feature on or off in Application Preferences.

Microsoft Excel import
FileMaker Pro now supports direct import of worksheets (.XLS files)
from Microsoft Excel, including versions 4.0, 5.0, and 8.0 for the
Mac OS, and versions 4.0 through 8.0 for Windows. Additionally, you
can import a specific worksheet from a Microsoft Excel workbook.

Chapter 5: ODBC import with FileMaker Pro
This chapter explains how to import data from ODBC sources, a new
feature in FileMaker Pro 4.1. See the FileMaker Pro User’s Guide for
information about importing other file types.

What is ODBC?
Open Database Connectivity (ODBC) is a standard language that
enables compliant applications to access data from many different
database management systems (DBMSs). It allows an application
accessing data, for example, FileMaker Pro 4.1, to make a request
without database-specific calls that work with only one DBMS.
An application makes its request, or query, for data using Structured
Query Language (SQL, pronounced “sequel”). Each DBMS that
supports ODBC recognizes a common subset of SQL statements.
Driver
Manager

ODBC
Driver

FileMaker Pro sends SQL
requests to the driver manager,
which sends them to the DBMS
through an ODBC driver
The ODBC driver sends the
requested data back to the
driver manager, which passes
it to FileMaker Pro

DBMS or
data source
FileMaker Pro interacting with a DBMS via SQL

ODBC terminology
To use the ODBC import feature, it’s useful to understand the
following terms.
Term

Refers to

Open Database Connectivity
or ODBC

An application programming interface (API) that enables
FileMaker Pro to import data from other database
management systems (DBMS).

Database Management System An application that allows users to store, process, and
or DBMS
retrieve information in a database (for example,
FileMaker Pro).
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Term

Refers to

Structured Query Language
or SQL

A programming language that controls and interacts with a
DBMS (for example, is used by ODBC to access data).

Data source

The specific data that you want to access, including the
DBMS that is storing the data. For example, a DBMS can
be an Oracle database on a network or a text file or
Microsoft Excel table from your hard drive. Each data
source must be registered with the ODBC driver manager
before FileMaker Pro can import the ODBC data.

Query

Requesting, and then receiving, data from a DBMS.

Column

An attribute in a table, similar to a field in a FileMaker Pro
database.

Row

A collection of attributes in a table, similar to a record in a
FileMaker Pro database.

Join

Combining data from two or more tables into a single set of
records.

Driver manager

The control panel that manages communication between
requesting applications and data sources. When an
application makes a request via ODBC, the driver manager
routes the request through the correct driver to the correct
data source and returns the data to the requesting
application. All ODBC drivers and data sources to be used
on that computer are registered with the driver manager.

Driver

The ODBC driver translates an application’s SQL queries
into commands a particular DBMS can understand. It
processes ODBC calls, submits SQL requests to the data
source, and returns the data back to the driver manager,
which then routes it to the requesting application (for
example, FileMaker Pro).

ODBC support in FileMaker Pro
With FileMaker Pro 4.1, you can either import records into an existing
database or create a new database by opening an ODBC data source.
Not all ODBC functions are supported by FileMaker Pro 4.1.
FileMaker Pro supports ODBC as a requesting application, but not as a
data source. You can use FileMaker Pro to import data from other
ODBC data sources, but there is no ODBC driver that allows other
applications to access data in FileMaker Pro 4.1 via ODBC.
Note ODBC import is not supported in Windows 3.1, Windows for

Workgroups, or 680x0 Macintosh computers.
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FileMaker Pro is certified with the following ODBC data sources
and drivers:
Platform

Certified ODBC data sources

Mac OS

Oracle 7 (INTERSOLV)
Text (INTERSOLV)

Windows 98, Windows 95, Windows NT

Microsoft Excel (INTERSOLV, Microsoft)
Microsoft Access (Microsoft)
Oracle 7 (INTERSOLV)
SQL Server (INTERSOLV, Microsoft)
Text (INTERSOLV, Microsoft)

The Microsoft Excel and Microsoft Access ODBC drivers are available
with Microsoft Office. Trial versions of the other drivers are included
with FileMaker Pro. For information on purchasing ODBC drivers, visit
the INTERSOLV Web site (http://www.intersolv.com) or contact
another ODBC driver manufacturer.
If you already have ODBC drivers installed and you have defined data
sources, you’re ready to import ODBC-compliant data into
FileMaker Pro.

SQL support in FileMaker Pro
The FileMaker Pro query builder helps you easily search a DBMS, fetch
specific records, and import the resulting records into a FileMaker Pro
database.
FileMaker Pro provides an easy-to-use interface to create SQL queries
containing the Select keyword and the Where and Order By clauses. You
can also type SQL statements directly in the SQL query box.
Use the Select keyword to specify which tables and columns your SQL
query will contain. For example, the following SQL statement,
containing only the Select keyword, would retrieve all the records
(rows) from the Company_Name and the Amount columns in the
Sales_data table:
SELECT Sales_data.Company_Name, Sales_data.Amount
FROM Sales_data
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Use the Where clause to further narrow down the records being
retrieved. For example, use the greater than (>) operator to return
records where the amount sold is greater than 3,000:
SELECT Sales_data.Company_Name, Sales_data.Amount
FROM Sales_data
WHERE Sales_data.Amount > 3000

You can also reduce the number of records by creating a join with
another column. For more information, refer to the example in
“Specifying a SQL join” on page 5-17.
Use the Order By clause to sort the records before they are imported. To
sort the above records in descending order (from the highest to the
lowest sales amounts) the SQL statement would read:
SELECT Sales_data.Company_Name, Sales_data.Amount
FROM Sales_data
WHERE Sales_data.Amount > 3000
ORDER BY Sales_data.Amount DESC

Use the Select, Where,
and Order By tabs to build
your SQL query

Click to add choices
into the SQL query
below

Make choices above or
type your SQL query

Click to begin the
SQL query
Building a SQL statement in the FileMaker Pro query builder

To create SQL queries in FileMaker Pro, choose Import/Export then
Import Records from the File menu, then the ODBC file format. If the
data source has been configured, you can build your SQL query. Refer
to “Importing from the data source” on page 5-12 for more information.
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Importing ODBC data: an overview
The procedures to import ODBC data can vary depending on which
driver you are using. For example, the steps to import data using the
Oracle or SQL Server ODBC driver vary from the steps using the Text
driver. Additionally, steps may vary from one ODBC driver
manufacturer to another. Refer to the documentation available in the
retail version of the ODBC driver for more information.
Here are general steps to import ODBC data:
1. If necessary, install the ODBC driver.
2. In the ODBC control panel, choose the driver and data source.
3. Use the FileMaker Pro query builder to generate a SQL query.

The data resulting from the query can then be imported into a
FileMaker Pro 4.1 database.

An ODBC import example
To help you get acquainted with importing data from ODBC sources,
FileMaker Pro 4.1 includes a sample database, ODBC-compliant data,
and evaluation ODBC drivers. You can work through the examples in
this chapter using an ODBC text driver on your system, or you can
install the INTERSOLV evaluation drivers.
Use the ODBC example files, along with the instructions below, to
import ODBC data from two text files, Salespeople and Sales_Data.

1 The Salespeople table has information for seven employees, such as
their name, their manager’s name, their sales region, and their
employee identification number.

1 The Sales_Data table has 250 records tracking sales that the
employees have made.
In the next three sections, you’ll import data from the tables by creating
SQL statements. You can then evaluate the imported data in the
FileMaker Pro Sales Reports database.
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Note The instructions provided work with Windows 98, Windows 95,

Windows NT, and Mac OS 8.0. If you’re using Mac OS system 7.6.1 or
earlier and have not installed the Appearance Manager extension,
options presented in dialog box tabs will appear in pop-up menus.

Choose SQL clauses from
pop-up menus in Mac OS
7.6.1 and earlier

Choose SQL clauses from
tabs in Mac OS 8.0 and later

The FileMaker Pro query builder dialog box in Mac OS 7.6.1 (top) and Mac OS 8.1

Installing the ODBC drivers
A 30-day evaluation copy of the INTERSOLV ODBC drivers is included
in the ODBC folder in the FileMaker Pro 4.1 folder:
Windows:

C:\Program Files\FileMaker\FileMaker Pro 4.1\ODBC\ODBC Installer
Mac OS:

Mac HD:FileMaker Pro 4.1:ODBC:ODBC Installer
Note If you already have ODBC drivers installed, you can use them to

import ODBC data. Choose Import/Export from the File menu, Import
Records, and then choose the ODBC file format.
To work through the ODBC import examples in this chapter, install the
trial Text driver. Be sure you can reinstall your original drivers before
replacing them with the INTERSOLV evaluation drivers.
Important The ODBC drivers are the link between FileMaker Pro and

ODBC-compatible data sources. FileMaker, Inc. cannot guarantee that
third-party ODBC drivers will work correctly in all situations. Some
troubleshooting tips for the INTERSOLV ODBC drivers have been
included in the FileMaker Pro 4.1 Read Me, located on the CD-ROM.
For more information, visit the INTERSOLV Web site.
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Windows:

To install the trial ODBC drivers in Windows 98, Windows 95, or
Windows NT, double-click the Setup.exe icon in the ODBC Installer folder
inside the ODBC folder. Follow the onscreen installation instructions, and
choose the default behavior where possible. When prompted for product
registration information, type your name, company name, and type eval
in the serial number box. Leave the Registration Key blank.
Mac OS:

To install the trial ODBC drivers in the Mac OS, double-click the ODBC
Mac PPC Installer icon in the ODBC Installer folder inside the ODBC
folder. Follow the onscreen installation instructions. When prompted for
a serial number, press Return. Leave the Registration Key blank. Continue
the installation by choosing the default options.

Configuring the ODBC control panel
Configuring the ODBC control panel can vary depending on which
driver you’re using.
Here are general steps to configure the ODBC control panel:
1. Choose the ODBC driver that will work with your data source.
2. Specify the data source and data source options (for example, the

Salespeople and Sales_Data files).
3. If necessary, specify the tables you’ll be importing from and the

column names.
For this example, we’ll configure the data source in the ODBC Example
folder using the INTERSOLV Text driver.

Choosing the driver and data source
These instructions assume you have an ODBC driver installed. To install
the INTERSOLV evaluation ODBC drivers, see the previous section.
1. In the User DSN tab of the ODBC control panel (called 32bit ODBC

in Windows and ODBC Setup PPC in the Mac OS), click Add.
2. Select the type of driver to work with.
Windows:

Choose the INTERSOLV 32-BIT TextFile.
Mac OS:

Choose INTERSOLV Text PPC.
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3. Click Finish.
4. In the General Tab of the ODBC Driver Setup dialog box, begin

configuring the driver by specifying the data source name.
For this example, type ODBC Demo.
5. Supply a description of the data source in the Description box. The

description can be whatever you choose.
For this example, type ODBC Import into Sales Reports.fp3.
6. In the Database Directory box, specify the path to the data source.
Windows:

Type the path: C:\Program Files\FileMaker\FileMaker Pro
4.1\ODBC\ODBC Example.

Add ODBC columns
in the Advanced tab

Specify the data source name,
description, and directory

Select to import
column names

Windows 32bit ODBC control panel
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Mac OS:

Click the Select Directory button and locate the folder containing the
data source (the ODBC Example folder, inside the ODBC folder in
the FileMaker Pro 4.1 folder). Click Select ODBC Example.
Add ODBC columns in the Define tab

Specify the data source name,
description, and directory

Mac OS ODBC Setup PPC control panel

7. Select the Column Names in First Line checkbox.
8. Click the Advanced Tab to specify additional settings.
9. In the Advanced tab, verify that the Data File Extension information

is correct.
For this example, the data file extension for the sample data source
files should be TXT.
10. Verify that the Action for Undefined Tables is Guess Definition

(Windows) or Guess (Mac OS).
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Leave the control panel open and continue to the next section.

Choose Guess Definition
to retrieve column names

Click Define to
specify ODBC tables

Advanced options in the Text ODBC control panel (Windows)

Specifying the tables and columns in Windows
After choosing and configuring the ODBC text driver in the ODBC
control panel, you specify the tables and columns to import.
1. In the Advanced tab of the Windows ODBC control panel, click

Define.
2. In the Define File dialog box, change the Files of type option to All Files.
3. Select the Sales_Data table, located in the ODBC Example folder,

and click Open.
4. Select the Column Names in First Line checkbox.
5. For column information, click the Guess button. The ODBC driver

will attempt to retrieve the column names from the specified table.
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It may take a few moments to retrieve the column names.

Click Guess
to insert
column
names
Select to retrieve column
names from the ODBC table

6. Select the Date_Sold column and verify that the Type and Mask values

are correct.
The Type should be Date, and the Mask should be m/d/yy.
When importing columns that store date information, you should
verify that the driver recognizes the correct column type and mask,
especially if the data source is from a Unix computer.
7. Click OK.

This saves the information for the Sales_Data table.
8. Specify the information for the Salespeople table by following steps

2-7 above.
Click the close box to close the control panel.

Specifying the tables and columns in the Mac OS
After choosing and configuring the ODBC text driver in the ODBC
control panel, you specify the tables and columns to import.
1. In the Mac OS, click the Define tab.

The Sales_Data table appears in the Table pop-up menu. If
Salespeople appears, switch to the Sales_Data table.
2. Select the Column Names in First Line checkbox.
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3. For column information, click the Guess button. The ODBC driver

will attempt to retrieve the column names from the specified table.
It may take a few moments to retrieve the column names.

Click Guess to
insert column
names

Select to retrieve column
names from the ODBC table

4. Specify the information for the Salespeople table.

In the Table list, choose Salespeople.
You’ll be prompted to save changes to the table definition. Click Yes.
5. Click the Guess button to retrieve the column names for the

Salespeople table, then click OK. Click Yes to save changes, then click
OK again.

Importing from the data source
After you’ve specified and configured the data source, you can open
your FileMaker Pro 4.1 database and import ODBC data. There are three
general steps involved in importing data with ODBC:

1 specifying the data source in FileMaker Pro
1 creating a SQL query using the Select, Where, and Order by clauses
1 importing the results of the SQL query into FileMaker Pro

ODBC import with FileMaker Pro 5-13

Connecting to the data source from FileMaker Pro
To specify the data source in FileMaker Pro:
1. Open the FileMaker Pro database file you’ll import data into.

For this example, open the Sales Reports database file, located in the
ODBC Example folder.
2. In Browse mode, choose Import/Export from the File menu, then

choose Import Records.
3. Choose the file import format.
Windows:

For Files of type, select ODBC Data Source.
Mac OS:

Select ODBC in the Show pop-up menu.

Select ODBC Data Source
to import ODBC data
Importing data into FileMaker Pro

4. In the Select ODBC Data Source dialog box, select the name of the

data source to import from, and then click OK.
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For this example, select ODBC Demo, the data source name you specified
in the previous section, “Configuring the ODBC control panel.”

Select the ODBC data source
you previously configured

5. If appropriate, enter the user name and password for the data source

you selected, and click OK.
If a user name and password appear, delete them and click OK to
proceed. The ODBC example files have no user name or password.

Specifying the SQL query in FileMaker Pro
In FileMaker Pro, you build your query in the Specify ODBC SQL
Query dialog box. Start by using the SQL Select clause to specify what
data you want to extract from the data source.
1. If there is already a SQL statement in the SQL Query box, click

Clear Query.
To confirm that you want to delete the query, click Clear.
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2. In the Select tab, click the table you’ll import from.

Specify the columns from each
table to insert into the SQL query

Click to add choices
into the SQL query
below
As you make choices in
each tab, the SQL query is
automatically generated

Click to begin the
SQL query

SQL statement retrieves four columns from the Salespeople table

For this example, select the Salespeople table.
The columns associated with the Salespeople table appear.
3. Select a column to insert into your SQL query and click Insert into

SQL Query.
Select the Salesperson ID column, then click Insert into SQL Query. This
moves the SQL statement into the SQL Query box.
4. Insert additional columns into the SQL query by double-clicking on

the column name.
Double-click the following columns: Salesperson, Sales_Manager, and
Sales_Region.
5. Click Execute to map the ODBC columns to FileMaker Pro fields.

The next section, “Importing ODBC data with a join” on page 5-17,
introduces the Where and the Order By tabs.
Note You can also type a SQL statement directly into the SQL

Query box.
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Importing the results of the query into FileMaker Pro
After building the SQL query in the Specify ODBC SQL Query dialog
box, you’re ready to import the resulting records into FileMaker Pro.
1. In the FileMaker Pro Import Field Mapping dialog box, match the

fields you want to import on the right with the data source columns
on the left by selecting Matching Names from the View By list.
You can also drag the FileMaker Pro fields on the right side to line up
with the ODBC columns on the left (for example, move the
Salesperson_ID field on the right up to the first position, and so on).
2. Make sure the columns on the left have an arrow to their right

between the column name and the field name.

Choose Matching
Names if column
names match
FileMaker Pro field
names

Columns must be aligned with
FileMaker Pro field names
To import data, there must be an arrow
between the column and field name

Click to add new records
FileMaker Pro Import Field Mapping dialog box

Click to import
records

3. Click Add new records, and then click Import.
4. If you see the Import Options dialog box, select options, then

click OK.
Seven records should be imported into the Sales Reports database. To
stop importing, press Esc (Windows) or Command-period (Mac OS).
To delete the records already imported, choose Delete All from the
Mode menu.
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Importing ODBC data with a join
Use the Where tab in the FileMaker Pro query builder to create a
multi-table SQL query, or join. A join combines data from two or more
tables into a new table.

Specifying a SQL join
In this example, we want to view a report that contains information
about sales transactions (from the Sales_Data table) along with
information about the salesperson (from the Salespeople table). To
ensure that the data is combined in a meaningful way, you should link
the two tables with a matching field.
Because both tables in the ODBC example files contain the
Salesperson_ID column, we can create a variety of reports by doing a
join on the Salesperson_ID column.
Use the ODBC example files, along with these procedures, to create a
report that lists sales information for each salesperson.

The SQL query has joined information from the Sales_Data table and the Salespeople table

Note Before importing ODBC data, you must specify the ODBC driver

and data source in the ODBC control panel as described in “Configuring
the ODBC control panel” section from page 5-7 to page 5-12.
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To access the FileMaker Pro query builder, choose Import/Export then
Import Records from the File menu, then the ODBC file format. Refer to
“Importing from the data source” on page 5-12 for more information.
To do a join:
1. In the Specify ODBC SQL Query dialog box, click Clear Query to

remove the SQL statement from the SQL Query box.
To confirm that you want to delete the query, click Clear.
2. In the Select tab, click the Sales_Data table.

The columns associated with the Sales_Data table appear.
Select the Company_Name column, then click Insert into SQL Query.
3. Insert the following columns into the SQL query by double-clicking
the following column names: Amount and Salesperson_ID.
4. From the Salespeople table, insert the Salesperson column.
5. Click the Where tab to join data from both tables.

You also specify search criteria in the Where tab.
6. Verify that the Sales_Data table is showing in the Table list.

The top table is the equivalent of a SQL “left” table; the bottom is the
“right” table.
7. Select Salesperson_ID in the Columns box on the right.
8. The operator should be displaying an equal sign (=).
9. If necessary, change the bottom table to Salespeople.
10. Select Salesperson_ID in the Columns box on the right.
11. Click Insert into SQL Query.
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Creating a SQL join

Using the Where SQL clause

12. Click the Order By tab to sort the records before importing them into

FileMaker Pro.
13. Select the name of the column to sort by, Sales_Data.Amount.
14. Click Descending to sort the records from highest amount sold to

lowest amount sold.
15. Click Move.
16. Click Insert into SQL Query.
17. Click Execute.
18. Import the resulting records into FileMaker Pro, as described in

“Importing the results of the query into FileMaker Pro” on page 5-16.
250 records are imported into the Sales Reports database.
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SQL query using all three clauses: Select, Where, and Order By

You can use the Sales Reports database to view reports of your data.
Click Reports to select summary
reports on the ODBC data

The SQL query imported
250 records from both
data source tables

ODBC data imported into the Sales Reports database

To view a summary report of total sales for each salesperson, click the
Reports button, then the By Salesperson button.
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Choose a report in the Sales Reports database

Using ODBC import with ScriptMaker
As with other import script steps, you can create an ODBC script that
hides all dialog boxes during an ODBC import. Because FileMaker Pro
interacts with an ODBC driver, however, some options behave
differently than when used with other scripted imports:

1 The Restore import order option stores the field order in the Import
Field Mapping dialog box, similar to other scripted imports.

1 The Specify File option stores the path to the data source, the user ID and
password, and the SQL query to be executed against the data source.
To save the user name and password, you must also select the Save
user name and password checkbox in the ODBC Enter Password
dialog box.

1 The Perform without dialog option hides all dialog boxes encountered
during an ODBC import.
If you select this option but you have not specified a file, you will
need to manually select ODBC in the Open File dialog box while
performing the import script.
Note The ODBC import feature saves the complete data source path

information, user ID and password, and SQL query from the previous
ODBC import. Keep this in mind when selecting the Restore import order
or Specify File options.
In addition, the Set Error Capture ScriptMaker step will suppress all
ODBC errors and alerts that might occur during an ODBC import.
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ODBC considerations
Keep the following considerations in mind when importing data
using ODBC:

1 The ODBC drivers included with FileMaker Pro 4.1 are for
evaluation purposes only; visit the INTERSOLV Web site
(http://www.intersolv.com) for purchasing information or check with
the application providing the data source for other ODBC drivers.

1 Different ODBC drivers might present very different configuration
interfaces. Contact the driver manufacturer for more information.
Additional tips are available in the FileMaker Pro 4.1 Read Me file
and the FileMaker, Inc. Web site (http://www.filemaker.com).

Appendix A: MacIPX control panel
You can use the MacIPX control panel to:

1 select the network interface for your applications that use MacIPX
1 change the parameters that MacIPX uses (if necessary)
Important For enhanced performance, TCP/IP is recommended.

Using an Ethernet or token-ring network interface for MacIPX
The MacIPX control panel displays icons for the available network
interfaces, such as Ethernet, AppleTalk, and token ring. MacIPX
automatically configures itself for the first networking environment it
detects when the Macintosh starts.
AppleTalk users For information on selecting an AppleTalk interface and

related options, see “Using an AppleTalk interface for MacIPX” on
page A-4.
PCI Power Macintosh computer users (such as 4400, 7200, 7500, 8500, 9500 or
later and other Mac OS computers) These Mac OS models use Open

Transport networking.
Warning Be sure to use Open Transport version 1.1 or later.

To switch between network interfaces (Ethernet, Token Ring, or
AppleTalk):
1. Open the MacIPX control panel.
MacIPX control panel

2. Click one of the icons to select it.
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After you select the IPX interface, the
control panel displays the network
number and node number of your
Macintosh on the selected interface

The software on your computer system determines which icons
you see.
3. Click OK, and then close the MacIPX dialog box.
Note MacIPX 1.3.1 supports most Ethernet interface cards, as well as

the token-ring interface card from Apple Computer.

Selecting a frame type
A frame encapsulates packets of information in a recognizable format.
Each packet on the network must conform to a specific frame type to
successfully communicate with other computers on the network. After
you select the network protocol, you must select a frame type.
Important All computers communicating with each other on the network

must use the same frame type. The MacIPX control panel gives you the
option to Always Auto-Configure Frame Type. However, when IPX is using
more than one frame type on a network, MacIPX might not choose the
frame type you require. If you are unable to connect to FileMaker Pro
databases (using the Hosts dialog box) after configuring the MacIPX
control panel, you might have the wrong frame type selected for your
network. Try turning off Always Auto-Configure Frame Type and then select
the appropriate frame type manually. If you have questions about your
frame type, or are unsure how to configure MacIPX, check with your
network administrator.
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To have MacIPX select the frame type:
1. In the MacIPX control panel, double-click the selected network

interface icon.
You see the Access Configuration dialog box for your chosen
network interface. For example, if you click the Ethernet icon, you
see the Ethernet Access Configuration dialog box, where you can set
parameters for working with Ethernet.

The dialog box shows the
currently selected frame type

2. In the Access Configuration dialog box, click Always Auto-Configure

Frame Type.
3. Click OK to close the dialog box.

When you start up your computer, MacIPX determines the
appropriate frame type by monitoring packets on the network. When
this option is checked, the buttons for the frame types are unavailable.
To select a frame type manually:
1. In the Access Configuration dialog box, deselect Always Auto-Configure
Frame Type.
2. Click the appropriate frame type, and then click OK.

Check with your network administrator if you’re not sure which
frame type to select.
When you close the dialog box, you see an alert dialog box.
3. Click OK.
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To have MacIPX determine the appropriate frame type at any moment:
1. In the Access Configuration dialog box, click Auto-Configure Frame
Type Now. Then click OK to dismiss the message.

In the dialog box, MacIPX highlights buttons in sequence until it
determines the appropriate frame type.
2. Click OK to close the dialog box.

Using an AppleTalk interface for MacIPX
If your Mac OS computer is connected to an Apple LocalTalk network,
you must specify an AppleTalk interface to use MacIPX networking.
When you use AppleTalk, you must also select an IPX gateway.
Important Novell supplies MACIPXGW.LAN, a LAN driver (IPX

gateway) that can be run on Novell NetWare v3.11 or later servers,
which lets you use AppleTalk to share information with other computers
on the IPX network. Contact your Novell dealer or use an online service
to get this driver. To install the LAN driver on your Novell server, see
your Novell system administrator or the documentation that came with
the driver.
To select an AppleTalk network interface:
1. Open the MacIPX control panel.

The MacIPX control panel is installed in the Control Panels folder
inside the System Folder.
2. If necessary, click the AppleTalk icon to select it and then click the

close box.
Your computer then sends IPX packets encapsulated in AppleTalk,
which are delivered on the LocalTalk network to an IPX gateway.
The gateway decapsulates these packets and routes them over an IPX
network. See the following steps for information on selecting a
gateway.
To have MacIPX select an available IPX gateway:
1. In the MacIPX control panel, click the selected AppleTalk icon.

You see the AppleTalk Access Configuration dialog box.
2. In the AppleTalk Access Configuration dialog box, choose an

AppleTalk zone that has an IPX gateway.
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3. Click Always Auto-Select an IPX Gateway from the Selected Zone.
4. Click OK to close the dialog box.

When the computer starts up and detects that it’s connected to an
AppleTalk networking interface, such as LocalTalk, it selects an
appropriate IPX gateway in the specified zone. In some cases (for
example, if you get an error message), you need to select the gateway
yourself.
To select an IPX gateway yourself:
1. In the AppleTalk Access Configuration dialog box, deselect Always
Auto-Select an IPX Gateway from the Selected Zone.
2. Choose an AppleTalk zone where an IPX gateway is installed.

When you click a zone name, you see a list of available IPX
gateways.
3. Click an IPX gateway.
4. Click OK to close the dialog box.
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Setting advanced MacIPX parameters
From the MacIPX control panel, you can set other parameters that affect
MacIPX operations.
Important Only a certified network engineer or administrator should

change the advanced parameters. Changing the parameters without a
good understanding of their functions can adversely affect the
performance of MacIPX. For more information, see your network
administrator or contact your Novell dealer.
To set advanced parameters:
1. In the MacIPX control panel, click Advanced Options.

You see the MacIPX Parameters dialog box.

Click to reset the
default values

2. Set the parameters you want and click OK to save your changes. You

must restart your computer for the changes to take effect.
Note To restore the parameters to the default settings provided by

Novell, click Restore Defaults and restart your system. If you make
changes to the settings and want to restore the parameters to what they
were when you opened the dialog box, click Cancel.
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Use the information in the following tables to set parameters for:

1
1
1
1

MacIPX
SPX (Sequenced Packet Exchange)
SAP (Service Advertising Protocol)
RIP (Routing Information Protocol)
MacIPX parameter

Function

Disable IPX
Diagnostic Services

Disables the IPX Diagnostic Services, used by some network
management tools. Disabling IPX Diagnostic Services can
reduce the amount of memory that MacIPX uses. Click this
parameter if you don’t use any network management tools, or if
your tool doesn’t use IPX Diagnostic Services.

Maximum Network
Packet Size

Limits the maximum network packet size. The value can’t be
greater than the maximum value supported by the physical
network. Enter 0 (zero) to let MacIPX determine for itself what
value to use.

Enable IPX
Checksumming

Enables checksumming of IPX packets. The option is
unavailable if the current network doesn’t support IPX
checksumming.

For the following SPX parameters, you can enter any value between 0
and 9999. The values for Abort Timeout, Listen Timeout, and Verify Timeout
apply only to those SPX connections using the “watchdog,” such as
those used by FileMaker Pro 4.0.
SPX parameter

Function

Abort Timeout

Sets the amount of time that SPX waits, without receiving any
response from the other side of the connection, before it
terminates the session. The timeout number is expressed in ticks
(with 60 ticks per second). The default value is 2400 ticks, or 40
seconds.

Listen Timeout

Sets the time that SPX waits (without receiving a packet from the
other side of the connection) before it requests the other side to
send back a packet assuring that the connection is still valid. If
SPX hasn’t heard from the other side of the connection within this
time, it sends packets to the other side asking for verification that
the connection still exists. The default value is 1200 ticks, or 20
seconds.

Verify Timeout

Sets the frequency at which SPX sends a packet to the other side
of a connection to inform it that its side is still active. If no
packets are being exchanged on the SPX connection by the
software that established the session, SPX sends packets at
regular intervals to make sure that the connection is still working.
The default value is 480 ticks, or 8 seconds.
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SPX parameter

Function

Default Retry Count

Specifies the maximum number of times that SPX attempts to
retransmit a packet before determining that the packets can’t be
sent, and then closes the connection. The default value is 10
times. An application can override the value in this field.

Minimum Retry Count

Specifies the minimum number of times that an SPX packet must
be retransmitted. If an application has a retry count setting that is
too low, you can override it by setting this parameter. The default
value is 0 (zero) times.

For the following SAP parameters, you can enter any value between 0
and 9999, but an application can override the values you set.
SAP parameter

Function

Query Interval

Specifies the time that must elapse before an SAP query is
retransmitted. The default value is 120 ticks, or 2 seconds.

Query Attempts

Specifies the number of times that an SAP query is transmitted.
The default value is 3 times.

Receive Buffers

Specifies the number of buffers to handle responses returned
from SAP queries. The default is 20 buffers.

For the following RIP parameter, you can enter any value between 0
and 9999.
RIP parameter

Function

Retry Interval

Specifies the time that must elapse before a RIP request is
retransmitted. The default value is 0 ticks, which lets the MacIPX
determine what the interval should be, based on the network
configuration.

Appendix B: Installing Win32s
If you are using Windows 3.1 or Windows for Workgroups 3.11, you
need to install Win32s 1.30c before installing FileMaker Pro. After
installing Win32s, you will still be able to run all the applications you
currently use. If an earlier version of Win32s is installed on your system,
you must first remove the older version.
To determine the version of Win32s that’s installed on your computer:
1. In the File Manager, click WIN32S16.DLL, located in the
\WINDOWS\SYSTEM directory.

The file is highlighted.
2. Select Properties from the File menu of the File Manager.

You see the version.

Removing earlier versions of Win32s
To completely remove an earlier version of Win32s:
1. Modify the following line from the [BOOT] section in the
SYSTEM.INI.

Change DRIVERS=MMSYSTEM.DLL WINMM16.DLL
to the following: DRIVERS=MMSYSTEM.DLL
2. Remove the following line from the 386 Enhanced [386Enh] section
of the SYSTEM.INI file:
DEVICE=<WINDOWS>\<SYSTEM>\WIN32S\W32S.386

where <WINDOWS> and <SYSTEM> are the locations of your WINDOWS
and SYSTEM directories. In a normal Windows configuration the line
will read DEVICE=C:\WINDOWS\SYSTEM\WIN32S\W32S.386
3. Exit and restart Windows.
4. Delete the following files from the <WINDOWS>\<SYSTEM>
subdirectory or from the SYSTEM directory in network installations:
W32SYS.DLL
WIN32S16.DLL
WIN32S.INI
WINMM16.DLL
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5. Delete all the files in the <WINDOWS>\<SYSTEM>\WIN32S
subdirectory or the <SYSTEM>\WIN32S subdirectory in network
installations. Then delete the WIN32S directory itself.

The above changes take effect the next time you run Windows.
Note <WINDOWS> refers to the Windows installation directory. On a
networked Windows installation, the system directory may be located
on a shared remote volume. If you are removing only WIN32s from your
machine, then you do not need to remove the shared files in <SYSTEM>
and <SYSTEM>\WIN32S. Before removing these files from the shared
network, make sure that all users that use Win32s have removed the
references to Win32s from the SYSTEM.INI file.

Installing Win32s 1.30c
To install or update Win32s:
1. In the Program Manager, click the Main group.
2. Open the 386 Enhanced control panel and change the virtual memory

type to Permanent.
3. Make sure the swap file size is at least 20480 KB.
4. Select Use 32-Bit Disk Access and Use 32-Bit File Access, if available.

Change virtual
memory type to
Permanent
Set swap file size to
at least 20480 KB

Enable 32-Bit
Disk Access

Enable 32-Bit
File Access
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5. Click OK.

If you made changes, you need to restart Windows before installing
Win32s.
6. In the File Manager, open the Disk 1 directory that’s in the Win32s

directory on the FileMaker Pro CD-ROM.
7. Double-click the SETUP.EXE program and follow the Win32s setup

instructions.
8. When the Win32s installation is complete, the FreeCell Setup dialog

box appears.
9. FileMaker, Inc. recommends that you install and run the game

FreeCell, because it can help verify your Win32s software
installation.
10. Restart the machine, then install FileMaker Pro.

See “Installing with Windows 3.1, Windows for Workgroups,
or Windows NT 3.51” on page 2-7, for step-by-step instructions.

